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Geosoft License Agreement
GEOSOFT agrees to supply the Licensed Program(s) as specified in my purchase order. Geosoft shall grant me a nontransferable, non-exclusive license to use the Licensed Program(s), subject to the Terms and Conditions herein contained.
Should there be a separate signed agreement between you and Geosoft, or between your company and Geosoft, pertaining to the
licensed use of this software, that agreement shall take precedence over the terms of this agreement.
1.

DEFINITIONS:

In this Agreement:
"Licensed Program(s)" means the actual copy of all or any portion of Geosoft’s proprietary software technology, computer software
code, components, dynamic link libraries (DLLs) licensed through the Geosoft license server, including any modifications,
improvements or updates provided by GEOSOFT.
“Effective Date” is the date the Geosoft license is installed. This date is recorded by the Geosoft License server when the Licensed
Program(s) is installed.
"Services" means the Services described on Section 4.
"Termination" means the occurrences contemplated by Section 6 and 7.
2.

LICENSE:

GEOSOFT grants to me a non-transferable and non-exclusive license to use the Licensed Program(s) for my own purposes
whereby the Licensed Program(s) are being used only by myself, on one computer, at any one time.
Title and all intellectual property rights in and to the License Program(s), including, without limitation, copyright, trade secrets and
trade marks, shall remain with GEOSOFT. I agree to refrain from raising any objection or challenge to such intellectual property
rights, or from assisting or causing or permitting other(s) to do so, during the term of the Agreement and thereafter
I may not assign this Agreement or any part thereof or sub-license the rights granted herein, or lend, rent, time-share, sell or lease
the software without the prior written consent of GEOSOFT.
I may not attempt to reverse engineer, de-compile or disassemble the software.
I may not make any attempt to circumvent the License Manager that controls the access to the software use.
3.

TERM:

The Term of this Agreement shall commence on the Effective Date and shall continue until termination, as described in Section 6.
4.

SERVICES:

(i) According to the terms of my initial purchase, GEOSOFT shall make available to me, without additional fees such corrections
and improvements to the Licensed Program(s) as may be generally incorporated into the Licensed Program(s) by GEOSOFT.
(Normally this will be for a period of twelve (12) months).
(ii) GEOSOFT has a strong commitment to customer service and product support. GEOSOFT offers me, subject to applicable
Service Charge(s), continuing support in the form of email or telephone advice and other assistance in problem diagnosis and the
correction of errors or faults in the Licensed Program(s) during the life of this License. When a problem occurs which appears to be
related to errors or faults in the Licensed Program(s), I may contact GEOSOFT and GEOSOFT will make an honest effort to solve
the problem. However, GEOSOFT cannot guarantee service results or represent or warrant that all errors or program defects will be
corrected. Also it is to be noted that each Licensed Program is designed to operate on a Windows NT (sp 6 or later), Windows 2000
or Windows XP platform.
(iii) Further, if I request service relating to the modification of the Licensed Program(s) to meet a particular need or to conform with a
particular operating environment, GEOSOFT may, at its discretion, modify the Licensed Program(s) to meet these particular needs,
subject to applicable Services Charge(s). However, all intellectual property or other rights which may arise from such modifications
shall reside with GEOSOFT.
5.

PROTECTION AND SECURITY OF LICENSED PROGRAM

I agree that all additions, modifications, revisions, updates and extensions to the Licensed Program(s) shall be subject to all of the
terms and conditions in this agreement.
I acknowledge that all copies of the Licensed Program(s), provided by GEOSOFT or made by me pursuant to this Agreement,
including, without limitation, translations, compilations, partial copies, modifications, derivative materials and/or updated materials,
are proprietary, and the property of GEOSOFT, and may not be distributed to any other persons, without GEOSOFT’s prior written
consent.
I will not provide or otherwise make the Licensed Program(s) available to anyone in any form without GEOSOFT's prior written
consent.
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6.

TERMINATION:

This agreement shall terminate upon the termination date, if any, specified in your purchase agreement with Geosoft.
This agreement may be terminated only upon thirty-days prior written notice to GEOSOFT.
GEOSOFT may terminate this Agreement upon prior written notice effective immediately if I fail to comply with any of the terms and
conditions of this Agreement.
This Agreement shall terminate automatically upon the institution, or consenting to the institution of proceedings in insolvency or
bankruptcy, or upon a trustee in bankruptcy or receiver being appointed for me/us for all or a substantial portion of my/our assets.
7.

EVENTS UPON TERMINATION:

I shall forthwith discontinue use of the Licensed Program(s), on the day Termination shall occur and agree not to resume such use
in the future without written authorization from GEOSOFT.
I shall uninstall and remove all software from my computer. Within thirty days after Termination, I shall destroy all physical and
digital copies of the Licensed Program(s). This obligation relates, without limitation, to all copies in any form, including translations,
compilations, derivatives and updated materials, whether partial or complete, and whether or not modified or merged into other
materials as authorized herein.
8.

WARRANTY:

GEOSOFT does not warrant that the functions contained in the Licensed Program will meet my requirements or will operate in the
combinations which may be selected for use by me, or that the operation of the Licensed Program will be uninterrupted or error free
or that all program defects will be corrected.
Each Licensed Program shall be furnished to me in accordance with the terms of this Agreement. No warranties, either express or
implied, are made to me regarding the Licensed Program.
THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OR MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
9.

LIMITATION OF REMEDIES

I agree to accept responsibility for the use of the programs to achieve my intended results, and for the results obtained from use of
said Program(s). I therefore accept complete responsibility for any decision made based on my use of the aforementioned Licensed
Program(s).
In no event shall GEOSOFT be liable for any damages arising from performance or non-performance of the Licensed Program(s), or
for any lost profits, lost savings or other consequential damages, even if GEOSOFT has been advised of the possibility of such
damages, or for any claim against me by any other party.
10. GENERAL:
I agree that this Agreement is a complete and exclusive statement of the agreement with GEOSOFT.
This Agreement supersedes all previous Agreements with respect to the Licensed Programs, with the exception of a current signed
Technical Service Agreements.
GEOSOFT is not responsible for failure to fulfill its obligations under the Agreement due to causes beyond its control.
Should any part of This Agreement for any reason be declared invalid, such declaration shall not affect the remaining portion which
shall remain in full force and effect as if this Agreement had been executed without the invalid portion thereof.
The relationship between the parties is that of independent contractors. Nothing contained in this Agreement shall be deemed to
constitute or create a partnership, association, joint venture or agency.
The provision of this Agreement shall be binding upon me and GEOSOFT and my respective successors and permitted assigns.
This Agreement will be governed by the laws of the Province of Ontario and applicable laws of Canada.
11. YEAR 2000:
The Licensed Programs have been tested to conform to DISC PD2000 1:1998 Year 2000 Conformity Requirements
(www.bsi.org.uk/disc/year2000/2000.html), with the exception of clause 3.3.2, paragraph b. Section 3.3.2 paragraph b) requires that
inferences for two-digit year dates greater than or equal to 50 imply 19xx, and those with a value equal to or less than 50 imply 20xx.
The Licensed Programs will recognize all two digit years as 19xx. This is to prevent errors importing historical data that pre-dates
1950. All dates that follow 1999 must use four digit dates in the Licensed Programs.
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Finding More Help Information
There are several other functions included in the basic Oasis montaj help system that
may be useful to your work. The entire documentation for the system is available through
the online help system. This electronic library of information enables us to constantly
update the information and provide you with the most up-to-date information available.
The best way to find information in this system is to use the Search tab to perform a fulltext search of all help topics. If you still can’t find the information you’re looking for, the
Online Books help system contains complete Geosoft manuals and tutorials in Adobe
PDF format.
Contacting Technical Support
The list below provides contact information for Geosoft Technical Support around the
world.
North America

Europe and North Africa

Geosoft Inc.,
85 Richmond St. W., 8th Floor
Toronto, Ont.,
Canada
M5H 2C9

Geosoft Europe Ltd.
20/21 Market Place, First Floor
Wallingford, Oxfordshire
United Kingdom
OX10 OAD

Tel +1 (416) 369-0111
Fax +1 (416) 369-9599

Tel: +44 1491 835 231
Fax: +44 1491 835 281

Email: tech@geosoft.com

Email: tech.eu@geosoft.com

South America

Australia and Southeast Asia

Geosoft Latinoamerica Ltda.
Praça Floriano 51 / 19º Andar
CEP: 20031-050, Centro
Rio de Janeiro, RJ, Brasil

Geosoft Australia Pty. Ltd
14/100 Railway Road
Subiaco, WA, Australia
6008

Phone: 55 (21) 2111-8150
Fax: 55 (21) 2111-8181

Tel +61 (8) 9382 1900
Fax +61 (8) 9382 1911

Email: tech.sa@geosoft.com

Email: tech.au@geosoft.com

South and Central Africa
Geosoft Africa Ltd.
Buren Building, Second Floor
Kasteelpark Office Park
c/o Nossob & Jochemus Streets
Erasmuskloof X3, Pretoria
Tel: +27 12 347 4519
Fax: +27 12 347 6936
Email: tech.za@geosoft.com
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Chapter 1: Working with Praga4 Radiometrics
Praga4 provides an advanced solution for the mapping and processing of airborne and
ground gamma-ray spectrometry data acquired by modern spectrometers using NaI(Tl)
detectors. Praga4 is a radiometric processing package that uses the maximum
information stored in the gamma-ray spectrum to evaluate radiation of natural and manmade radioactive ground sources. The processing requires spectra at resolutions of 256 or
512 channels and auxiliary data channels such as, live time and STP (standard
temperature and pressure) altitude channels. If spectra with higher resolution (1024 ch)
are to be input, Praga4 will make an attempt to down-sample spectra to 512 channels.
To begin working with the Praga4 system a project must be created. The Praga4 project
stores information about the input database channels, processing parameters, radiometric
calibration constants, and other system settings. Multiple Praga4 projects can be created
for a single database. All Praga4 project files are stored in the directory
“_PRAGA_PROJECT” which is located in the same directory as the project database.
The Praga4 radiometric system is accessed from the montaj RPS (Radiometric
Processing System) menu. Once launched, the last Praga4 project used with the current
database is automatically opened.
For more information on working with Oasis montaj, see the Oasis montaj Mapping
and Processing System Quick Start Tutorials and for more information on working with
montaj RPS, see the montaj 256-Channel Radiometrics Processing System User Guide
and Tutorial. These tutorials can be accessed from the Help|Manuals and Tutorials menu
or found in the “C:\Program Files\Geosoft\Oasis montaj\hlp” directory.

Airborne and Ground survey modes
Praga4 is primarily designed for airborne projects and by default the functionality is set
for airborne data processing. Ground surveys, however, can be processed using a special
Ground Survey mode. When a new project is created (see below Create a new Praga4
project) you specify whether the project is an airborne or ground survey type. When the
project is loaded, Praga4 functionality is modified according to the project type.
Ground Survey mode comes with some simplifications and modifications over standard
airborne mode:
•

Ground mode does not use the altitude or cosmic channel. Therefore calibration
parameters for window (ROI) process such as altitude attenuation and cosmic
background are not required. Background has only one “instrument” component
which in fact includes cosmic background, assumed to be stable within the whole
survey area.
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•

For full-spectrum fitting there is no background modeling available. The only way
to define instrument background in full-spectrum sense is to import it from external
file.

•

Ground mode uses different model responses for spectrum fitting technique and
model response files have extension *.RSG instead of *.RSP for airborne models.
These are selected in the process of creating new project, namely in the step where
the type of spectrometer is selected. It is very important to select the spectrometer
with the correct volume of the detector because some other default parameters such
as stripping ratios and sensitivities are predefined based on detector volume
selection. Please be aware that processing parameters and shape of model responses
change considerably according to the change in the detector volume of
portable/ground spectrometers.

•

Unlike in the airborne mode, in the ground survey mode calibration parameters such
as background and sensitivity should be entered exactly for the actual detector, there
is no VOLUME parameter to correct for the detector volume.

•

There is no radon background removal process available in the ground survey mode
as ground survey geometry does not allow for radon removal techniques to work.

IMPORTANT: Please be aware that typical low-volume detectors of portable
spectrometers produce a very low number of counts per second. Typical accumulated
one-second spectrum is virtually empty with some count here and there. Both standard
window or LSQ fitting processing techniques are not suited to be used on spectra with
zero counts over many channels. To resolve this problem either the database should
already consist of spectra which were accumulated over sufficient time (over 100 seconds
for small 3-inch detectors) or if one-second spectra were collected, stacking option
should be used for processing. Stacking should use large enough number of spectra so the
result spectrum has no zero counts in the range of spectrum channels selected for given
type of processing.

Create a new Praga4 project
A Praga4 project requires as a minimum a database with 256 or 512 channel radiometric
spectra and a Cosmic channel. The Cosmic channel can be stored as one of the spectrum
channels or alternatively as an individual database channel. Radiometric processing also
requires a STP altitude channel for altitude correction. STP can be computed by Praga4,
in which case the Radar altitude, Pressure (or Barometric altitude) and Temperature
channels must be available. Please check units of above mentioned channels before
launching Praga4. Data collected by other than Pico Envirotec Inc. spectrometers should
also have a Live Time channel recorded. Live Time can be expressed either in seconds or
milliseconds. In the case that any of above mentioned channels (except for spectrum) is
missing, Praga4 can use default values, however results of the processing will be
compromised.
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TO

CREATE A NEW

P RAGA4

PROJECT :

1. Open an existing Oasis montaj project that has the RPS (montaj Radiometric

Processing System) menu loaded. (For more information on working with Oasis
montaj and the montaj Radiometric Processing System, see the Oasis montaj
MAPS Quick Start Tutorials and the montaj RPS User Guide and Tutorial).
2. Use the Data|Open Database menu to load the database you want to work with.
3. From the RPS menu, select Praga4. The Praga4 interface will be displayed.

Note:

If the current database does not have a Praga4 project associated with it, a
message will be displayed notifying you of this. Click [OK] to continue.

4. On the File menu, select New Project and the New Project dialog will be displayed.

Specify the name of your Praga4 project (e.g. Praga4.PGP). Should you want to
process Ground Survey data, select GROUND Survey option. This selection turns
Praga4 from AIRBORNE into GROUND mode and its functionality will be modified
to assist ground survey processing, also options applicable to airborne data processing
only will not be present. It is important to note that this is the only place where Praga4
can be turned into GROUND mode. Opening project which was saved as GROUND
Survey type will turn Praga4 automatically in the GROUND mode.
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5. Select the format of your input data as “Geosoft *.GDB” and then click the [Next>]

button.
The Select Geosoft *.GDB database dialog is displayed.

6. Select your current edited database (*.GDB) file and click the [Open] button. The

Define Aliases dialog will be displayed.

7. Using the Define Aliases dialog, define all the important radiometric channels. Select

the database (*.GDB) channel from the list on the left and click on the respective
button on the right. Don’t forget to set correct units. Some input channels can also be
modified using Multiply and Offset factors. There is an option to select Cosmic and
LiveTime as a member of the input spectrum array. Note that, after successful creation
of the Praga4 project, the Define Aliases dialog can be accessed again (and channel
definition changed) using the File|Change Alias menu. Click the [OK] button and the
Spectrum display dialog will be displayed.
8. The Spectrum display dialog asks you to Select Range of Valid Channels in the input

spectrum. This is a very important step as the data with other than radiation content
can compromise or even disable processes such as Compton removal or Principal

8 Chapter 1: Working with Praga4 Radiometrics

Component Analysis (PCA). It is good practice to set the low limit to the channel
with the peak of the scattered radiation (see below). High limit should exclude the last
channel which is usually used as a cosmic channel.

9. Select the spectrometer used. This setting determines which model detector set will

be loaded and used for LSQ fitting technique, some initial settings such as default
cosmic background levels are affected as well.
10. Current version comes with two sets of model responses for airborne detectors.

GRS10.RSP should be used with new Pico Envirotec Inc. (PEI) spectrometers;
GR820.RSP is intended for Exploranium GR-820 users. In the GROUND Survey
mode it is extremely important to select correct model set for actual detector volume,
sets for ground detectors have different extension (*.RSG) and part of the filename
suggests the detector volume (3IN = 3x3x3 inch, 2L = 2 litre etc.). Default settings of
ROI calibration constants (like stripping ratios or sensitivities) for new projects are
influenced by selection of the model response set (based on the detector volume).
11. Click the [OK] button and your Praga4 project will be created and displayed in the

Praga4 interface.
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Channel-to-energy calibration
Praga4 is designed to work with the full 256 or 512 spectrums. Careful channel-toenergy calibration of input spectra is essential for proper function of all processing
components. The most important procedures which require proper energy calibration are
spectrum windowing (for standard window processing and spectral-ratio radon removal)
and least-squares (LSQ) fitting using model responses. The current version of Praga4
assumes that photopeaks of individual radionuclides stay at the same positions through
the whole input dataset. Energy calibration procedure takes spectrum composed out of
model detector responses (used otherwise in the spectrum fitting technique) as a
reference target with the exact channel-to-energy definition. This model spectrum is
compared with the spectrum obtained by averaging of sufficient amount of input spectra
(to remove statistical noise). Peak positions of both, model and input spectra are
identified and 2nd order polynomial is computed, to translate the peak positions of the
input spectrum into peak positions of model spectrum. The process of peak identification
involves Compton continuum removal and peak deconvolution using Gaussian function
to obtain accurate positions. After the calibration was done, a) input spectra can be
physically stretched to match Praga4’s default channel-to-energy definition (used by
model responses) or b) default definition can be changed to match input spectra, so no
modification is done to the input spectra. The following procedure illustrates how the
channel-to-energy calibration is done.
TO

SET CHANNEL TO ENERGY CALIBRATION :

1. To begin you must create an average input spectrum. Click the [VIEW] button to

select LSQ FITTING and then select the Average control (the centre spectrum
display area will be split into two sections).
2. Using the [Spectrum Browsing Controls] start the spectrum averaging process.

Create smooth average spectrum which will represent the whole dataset. Praga4 uses
photopeaks of natural radionuclides in the energy calibration process. Therefore it is
necessary to avoid as much as possible data with the contribution of man-made
radionuclides. Because of the spectrum definition at low-energies, high content of
uranium in the averaged spectrum is desirable.
3. The next step is to start the channel-to-energy calibration process. To begin, from the

Options menu, select Spectrum Adjustments. The Spectrum Adjustments dialog is
displayed. The upper section of the dialog is used for spectrum energy calibration.
Graph shows (always non-stretched) average spectrum which was created before and
master spectrum, which is equivalent spectrum composed using model detector
responses. Vertical lines will show positions of main photopeaks.

10 Chapter 1: Working with Praga4 Radiometrics

The aim is to stretch the average spectrum in order to get a perfect match with the master
(model derived) spectrum.
Press NEW STRETCH button to start new energy calibration. Choose one of the three
following options:
•

Automatic 2nd order polynomial fit – simply press AUTO – Using Average
Spectrum button. Program will compute coefficients of 2nd order polynomial fit –
simply press Auto Stretch using Average spectrum button. Program will compute
coefficients of 2nd order polynomial and copy them into provided edit boxes.
Spectrum will be stretched to fit model response.

•

Manual using peak identification. Place mouse cursor at peak position you can
recognize and press left mouse button to draw vertical cursor. Then press right mouse
button to bring context menu and select the correct peak. The more peaks will be
identified, the more precisely the energy calibration will be done. After peak
identification, press the button MANUAL-Using Peaks.

•

Manual using direct entry of polynomial coefficients. Simply enter your guess of
coefficients and press MANUAL – Using Polynomial button.

In environments with substantial Cs-137 fall-out select option Include Cs-137.
To return to previous polynomial definition (energy calibration) – press Redo button
4. The next step is to decide on the Stretch effect of the energy calibration. This

parameter can be set on either the Spectrum Adjustments dialog (Select Stretch Type)
or the main Praga4 dialog (Stretch).
5. The energy calibration Stretch parameter has three options, None, Spectra (SPEC),

or Responses (RESP). If you select None, the energy calibration has no effect and no
modification is done to either input or model spectra. Default channel-to-energy
definition is used for all cursor and spectrum window operations and also for LSQ
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fitting technique. If you select Spectra (SPEC), the input spectra are physically
stretched to comply with the default channel-to-energy definition of model responses.
In this setting the channel width has constant value across the spectrum. And finally if
you select Responses (RESP), the default channel-to-energy definition used for
windowing process and LSQ fitting process is changed to fit input spectra. Entire set
of model responses is recomputed – stretched. In this setting the channel width does
not have (in general) constant value across the spectrum.
6. At this point you should check the results of the energy calibration. Note that, the

energy calibration will only be effective when the Stretch parameter (see 4. above) in
the main Praga4 dialog is set other than None.
7. To check the match of the input and model spectra, on the main Praga4 dialog, set

the View Mode to LSQ FITTING and switch on Sum control. Next, set the Stack
parameter for spectrum stacking to higher value (>25) to reduce statistical noise.
Then, using a combination of the [Next>], [Go], [Stop] or [Go SP] functions, bring
stacking into process and continue until you obtain spectrum with distinct and regular
photopeaks. Select all radionuclide that you expect to have contribution to the input
spectrum and also check that the range of channels defined by LSQ MASK includes
all important photopeaks (usually 250 – 2980 keV). Compare the match of the input
spectrum (black line) with the (on-the-fly) fitted model spectrum (thick color line).
Alternatively, use the Residual control (top-left) to assess difference of input and
model spectra.
8. To check the peak positions, first switch the View Mode to SPEC ANALYSIS and

select the R/Compton control to remove Compton continuum from the input
spectrum. Then, use the Scale arrows to scale-up the display in order to see better lowenergy photopeaks (352 and 609 keV uranium photopeaks are of particular interest for
the radon removal). In the Nuclide Info section, switch on the Natural nucl. control
to show expected positions of important photopeaks for natural radionuclide series.
Compare input spectrum photopeaks with lines which show their expected positions.
In this stage, it is also possible to press the GO control and investigate the stability of
peak positions along the flight line. The PeakDeco control is used to start process
which approximates photopeaks in the input spectrum by the Gaussian function in
order to find their actual positions. Grey lines annotated with their channel/energy
value are plotted over photopeaks centres.
9. To check the position of standard windows (ROIs), use the ROI control in the

Nuclide Info section of the main Praga4 dialog. Make sure that major photopeaks fall
into standard windows as expected. This functionality is available in LSQ FITTING
and SPEC ANALYSIS (R/Compton) modes.
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Input/Output settings and other important information
The Input/Output Settings dialog, access from the Options|Input/Output settings menu, is
used to define general parameters that have an influence on the processing and spectrum
display. The most important parameter is the Detector Volume. The Detector Volume
of a standard airborne system with 8-downward crystals in 2-detector packs is assumed to
be 32 litres. Enter 16 litres if the system has only one pack etc. If this parameter is
changed, background and sensitivity corrections of all processing techniques (read
below) are internally adjusted to reflect the change in the detector volume.

The Default Altitude (m), Default Press (kPa) and Default Temp (deg C) are “default
(radar) altitude, pressure and temperature” values that are used if any of those important
data channels are missing or not defined as radiometric input channels. By selecting
(checking) the Always control we will force the software to use the default values even if
the channel is available and defined for the input using Define Aliases dialog.
The Cosmic count filter len control, defines the “length of the moving average filter”
which is applied on the “Cosmic count” channel during processing.
The Show Upward control is used to switch between downward and upward-looking
detector spectra for the browsing and other spectrum operations available in the
Interactive mode. Note that, the Processing mode always uses downward spectrum
regardless the setting of this control.
The Draw threshold control sets the low-energy limit for the spectrum plot on the screen.
This has no influence on any radiometric calculations.
Calibration constants
Window based processing applied on either raw or PCA smoothed spectra requires a set
of calibration constants. These constants are used as important input parameters in
radiometric corrections according to IAEA (1991) standards. It is important to mention
that Praga4 also uses (window based) background and sensitivity calibration constants
for the LSQ fitting technique - to ensure that both methods provide comparable results
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for natural radioactivity data. Therefore, the quality of any processing technique is
strongly dependent on the quality of calibration constants.
The ROI definitions dialog, access from the Options|ROI definitions menu, is used to
enter all calibration constants for the current project. Always enter calibration constants
as for airborne system with 8-downward crystals (in 2-detector packs) – which is the
most common detector configuration. In the case that your actual configuration will
change to only one 4-crystal pack, leave your calibration constants as they are for 2-pack
system and change the Detector Volume parameter (see Input/Output Settings and other
important information above) from 32 to 16.
GROUND mode:
Please note that projects of type GROUND survey are treated differently. In the case of
detectors used for ground survey, calibration parameters should be entered exactly as
estimated for actual detector (volume). Therefore, there is no Detector Volume
parameter in Input/Output Settings Dialog.
Check validity of all input channels
Try browsing the spectra in “Interactive mode” (find details below in Chapter2:
Interactive mode). Make sure that the Line number, Fiducial, STP, Pressure,
Temperature and Cosmic count values are shown. These values should change their
values from fiducial to fiducial and line to line (except for default values) and their
values should be in the expected range. If not, something is wrong with the import or
(input) channel definition.
Open an existing Praga4 project
After launch of Praga4 from the Oasis montaj environment, the last Praga4 project
used for the current edited database (*.GDB) is automatically loaded. To open a different
Praga4 project that is associated with the current database, on the File menu, select Open
Project. Using the file browser dialog, navigate to the _PRAGA_PROJECT directory and
select the Praga4 project (*.PGP) that you want to open.
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Chapter 2: Interactive Mode
After opening a Praga4 project, the main dialog is shown and Praga4 is turned to
Interactive Mode. In this mode the following functions are available.
•

Spectrum browser

•

Photopeak identification

•

Least-squares (LSQ) spectrum fitting process

•

Assessment of Principal Component Analysis (PCA)

In the Interactive mode, no data are output in the database. However, using the [Save]
button, spectra and model responses that are currently on the display can be saved into
ASCII files. Use [MODE] button or combo-box to enter into Interactive mode.
Elements of the main GUI
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Spectrum browser
The Spectrum browser can be used to serve various purposes. It can be used to check
quality and stability of input spectra, to assess the outcome of channel-to-energy
calibration, to investigate relative contributions of natural radionuclides through the
dataset, to search for signatures of man-made radinuclides or to setup and prepare
Praga4 environment for processing tasks – namely LSQ fitting and PCA methods
(NASVD, MNF).
After opening the Praga4 project there should be the first input spectrum of the first
flight line displayed in black color. There might also be a model fitted spectrum shown
(using thick coloured line). To only see the input spectrum, switch the Sum control off.
Use the Scale arrows (
) to scale up or down the spectrum so you can clearly
observe spectrum features which are of interest. Use the Spectrum Browsing Controls

(

and (

) and (

) buttons to display the next or previous spectrum. Try (

)

) buttons to start quick run through spectra along the flight line or (

) and (
) buttons that will force run through the specified number of spectra or
run until end of flight line is reached. Use the dropdown list under the Flight Line bar to
skip to another flight line or use the slider bar below to pick randomly different spectrum
along the flight line.
While browsing through spectra, you should pay attention to flight line number, fiducial,
STP, pressure, cosmic data values. If they are not as expected, it maybe necessary to go
to the File|Change Alias menu and select different database channels, change data units
or apply transformation.
In order to better investigate spectrum signatures, it is possible to reduce statistical noise
by spectrum stacking or averaging process. To start the Stack function, enter number > 1
into the Stack box (bottom-right). In stacking, a moving average filter will be applied to
every spectrum channel (and to other auxiliary data such as fiducial, STP etc.) - once the
user starts to advance forward using [Next] or [Go] buttons.
To start the Average process, switch the Average control on. This action splits the
spectrum display into two sections - the top one contains usual input spectrum, and the
bottom section contains averaged spectrum which is updated with the advance forward
using the Spectrum browsing controls [Next] or [Go] buttons. Use the [CLR] button
(centre-left) to erase current averaged and stacked spectrum. Stack and Average functions
can be combined and run at the same time. Use the [Save] button (centre-left) to save
averaged spectrum to an external ASCII file.
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Photopeak identification
This functionality requires proper channel-to-energy calibration of the input spectra to be
completed (as discussed above). To investigate and identify spectrum photopeaks and
their positions it is recommended to apply sufficient degree of stacking (see above) to
the spectra, set Stack (bottom-right) to 25 or higher to reduce the statistical noise. When
you move your cursor over any part of the spectrum that is of interest and click the left
mouse button, vertical and horizontal cursors with attached information about
channel/energy position and the data value will be displayed. Clicking the right mouse
button will hide those cursors. To identify any spectrum photopeak, double-click the left
mouse button and the Nuclide database dialog will be displayed and the nuclide
photopeak which is closest to the cursor position will be highlighted. You can leave the
photopeak highlighted or select another one and click [OK]. After return to the Praga4
main dialog, the cursor will move to the position for the selected photopeak.
Photopeaks are better observed with the Compton continuum removed. Change View
Mode to SPEC ANALYSIS and using stacked spectra set the R/Compton control and
again if necessary, apply scaling to the spectrum display. The bottom section of the
spectrum display now shows spectrum with the Compton continuum removed. It may be
necessary to adjust low channel limit for the Compt/Rem Subset (middle-right). This
limit should be shifted in the direction towards higher energies from the peak of scattered
radiation at the very beginning of the input spectrum. If the limit is set below this point,
Compton removal might not work at all or the scattered radiation peak can be confused
with the genuine (primary radiation) photopeak.

Photopeaks can be located using the PeakDeco function (top-left) that approximates and
replaces photopeaks by Gaussian function, the center of which is assumed to be
searched position. Position is shown both in energy and channel number. PeakDeco and
PeakPlot (below) can also be used in the quality control to investigate spectrum
(Photopeak) stability across the dataset. This functionality internally uses Compton
removal function (above) and requires sufficient spectrum stacking.
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The presence of specific photopeaks – such as photopeaks of man-made radinuclides can
be uncovered by selecting the Peak Plot functionality. This feature is based on the
PeakDeco functionality described above with the difference that only short line
fragments are plotted at photopeak positions and they are not erased while browsing
forward spectrum-by-spectrum along the flight line. As a result, line fragments
accumulate and create some sort of scatter-gram. Browse through the whole flight line or
even through the whole dataset to get a record of all distinct photopeak positions. To
assist identification, it is possible to overlay photopeak lines for natural and the most
common man-made nuclides. To do so, switch on the Natural Nucl. and/or Man-made
n. controls. Use Peak Plot to discover which radionuclides are present in the area.
Double-click on the observed photopeak position to display the Nuclide database dialog,
that identity’s (highlights) the radionuclide. Peak plot can be erased using the [CLR]
button.

Note that, identification of all radionuclides is a strict condition for the LSQ fitting
technique when processing data with expected contributions of man-made radionuclides.
The radiation of the nuclide which might be omitted in the fitting process will be falsely
accounted to other nuclides.
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Least-squares spectrum fitting process
The Least-squares (LSQ) fitting process uses the set of model detector responses to find
contributions of individual nuclides to the input spectrum. In the interactive mode, LSQ
fitting process is automatically executed for every spectrum that is on display. To start
fitting process:
1. Set the View Mode to LSQ FITTING. From the group of display controls, set only

the Sum control on - to show fitted spectrum (sum of individual responses) presented
by a thick colored line plotted over the input spectrum.
2. Select nuclides to be fitted into input spectrum – usually K-40, U-238 and Th-232

plus Cs-137 in areas with substantial Cs fall-out.
3. Set safe channel range for the LSQ MASK (channels which are used in the fitting

process), for instance 450 – 2950 keV.
4. Make sure that Praga4 is using correct model response set for your project, the text

on the left from the project name should state “GRS10:” for Pico Envirotec Inc.
spectrometers and “GR820:” for the Exploranium GR-820 spectrometer. Information
about the spectrometer was stored during creation of Praga4 project.
5. Channel-to-energy calibration (discussed above) has to be completed and Stretch

control has to be set to either RESP (model responses are stretched to match input
spectra) or SPEC (input spectra are stretched to match model detector responses).
Now it is possible to browse through spectra in any desirable way (spectra can be also
stacked) and fitting process will be automatically done for every spectrum. Switch on the
Individual control to see responses of individual nuclides which contribute towards
fitted spectrum. You can press the [Go] button and observe variation in the contribution
of individual nuclides along the flight line.
Now include more man-made nuclides into fitting process and observe how the fitting
procedure attempts to include them into solution (even if they are not present in the data)
– to balance fluctuations in the radiation caused by the statistical noise. Note that
negative contributions are not excluded from the least-squares fitting solution. In
environments with very low or zero ground radiation, negative nuclide contributions can
naturally occur as a result of the statistical noise fluctuations after background has been
removed.
The Residual spectrum (the difference between input and fitted model spectrum) can be
used to identify various problems in the setup of the fitting process. Ideally, the residual
spectrum should have values close to the zero along the whole energy axis. Even small
shift between peaks of fitted and input spectra will be immediately revealed with the help
of the residual spectrum. (See below, residual spectrum in violet color.)
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Photopeaks of the nuclide that was omitted in the fitting process will be seen in the
residual spectrum. Spectrum presented below has significant content of 137Cs. Residual
spectrum contains 137Cs photopeak, in the case that only K, U, Th were selected for
fitting.

With Residual and Average controls on, residual (rather than regular input) spectrum is
averaged so the effects of systematic problems such as wrong energy calibration or
unaccounted radiation can be accumulated and easily recognized.
The differential spectrum can be used also to find lowest possible limit for the LSQ
MASK. Within the range of channels used for the fitting process (defined by LSQ
MASK), values of the residual spectrum should randomly fluctuate around the zero
(averaged values should be effectively zero). The figure below shows the low-energy
limit for the mask at the point where the residual spectrum starts to strongly deviate from
the horizontal energy axis.
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In the processing of man-made radiation data it is important to bear in mind that LSQ
MASK should include all major photopeaks of the man-made nuclides that are selected
for the fitting process. In the complicated situation with spectrum overlaps of more manmade radionuclides, it is good practice to step through the data one spectrum at a time
and visually check that fitting works as expected. The figure below presents the case
where unaccounted 60Co and 137Cs was falsely contributed to 40K and 238U respectively.

All settings for LSQ fitting process as seen in the dialog and tested in the Interactive
mode are used also for the actual processing. These settings (with other project settings)
are saved automatically at the beginning of processing session or manually using the
File|Save Project menu item.
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Note about full-spectrum background removal
Input spectra (raw, stacked or averaged) shown on the display have aircraft/cosmic
background removed. This is necessary for the assessment of the LSQ fitting process
which requires background to be removed before the fitting is applied. Background
components are defined using the Full Model Background Parameters dialog accessed
from the Options|Background model menu. This dialog also provides an option to
disable full-spectrum background removal for the fitting process (and spectrum display),
if necessary.
On the other hand, in SPEC ANALYSIS, Compton removed spectra used for
R/Compton, PeakDeco and Peak Plot displays do not have aircraft/cosmic background
removed. In this case we are interested in the photopeak positions, problems with
background definition or energy calibration might create false spectrum features which
would compromise Compton removal process. Note that ‘cosmic’ peak at 511 keV might
be seen when assessing low radiation data with the help of Compton removal
functionality.

Assessment of Principal Component Analysis
After statistics for NASVD/MNF is processed (eigenvectors computed and stored into
project), results can be assessed using functionality included in the Interactive mode. Set
View Mode to NASVD or MNF - you can either click repeatedly on [VIEW] button or
choose method from the combo-box.
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•

Select the EignVectors radio button to display PCA eigenvectors Use [Next]
and [Prev] buttons to browse through eigenvectors, scale and cursor functions
are available.

•

Select the EignValues radio button to display PCA eigenvalues. Use [Next]
and [Prev] buttons to change the number of eigenvalues to display. Scaling is
possible, cursor shows eigenvalue/eigenvector number.

•

Select CovMatrices radio button to display NASVD covariance matrix or
MNF signal/noise matrices along with their column or diagonal vectors.
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The Covariance Matrix Viewer enables users to investigate property of covariance
matrices. Covariance matrices are inputs to PC transformations which produce
eigenvectors used for analysis of the dataset or for the spectrum restoration process
using inverse transformation approach. The quality of the covariance matrix
(definition, smoothness or noise content) determines the quality of the PC
transformation and its outcome.
Default display setting shows greyscale image of the covariance matrix at the bottom
and the profile of one vector selected from the matrix in the upper segment of the
display. The position of the vector is indicated by the blue line across the matrix
image.
Click anywhere inside the matrix to select the vector
•

To change the vector direction – normally, column (vertical) vectors are plotted,
to show diagonal vectors –right-click and from the popup menu, select Change
cursor direction option. After change to diagonal direction, main diagonal is
selected and plotted.

•

To go to main diagonal, right-click and from the popup menu, select Go to Main
Diagonal option. If the main diagonal is selected, line drawn inside of the matrix
changes it’s colour to magenta.

•

To proceed to the next or previous vector – use the [
the bottom right of the display.

•

To scale vector plot – use the [
] arrow buttons on the bottom right of
the display. Use right-click popup menu to change scaling style to:

] arrow buttons on

1. Auto Scaling of Individual Vectors – using this option, vectors are automatically

scaled so that their shape (or shape changes) can be easily assessed.
2. Equal scaling for All Vectors – with this option it is possible to assess and compare

amplitudes of individual vectors.
Note that [Scale] arrow buttons can be used in both modes to adjust overall scaling
for the best fit of vectors in plot area.
•

Special plots for main diagonal – In radiometrics, main diagonals of covariance
matrices have special importance as the main diagonal (which contains variance)
is the place where the statistical noise accumulates. Relative noise fraction in the
other (off-diagonal) covariance vectors approaches to zero with increasing
number of spectra contributing to the covariance matrix. Exceptions from this rule
are recalibrated spectra, where channel count rates were interpolated. In this case,
part of the statistical noise is contributed also to the first off-diagonal. To assist
assessment of covariance matrix vectors around main diagonal, additional plots
are displayed when the main diagonal vector is plotted.
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1. In the case of data (signal+noise) covariance matrix, attempt is made to separate

signal part of the variance contained in the main diagonal vector; noise part is
computed as residual of the main diagonal vector and its estimated signal component.
This is done using redundant information within the covariance matrix. Main diagonal
(signal+noise variance) is plotted in RED, estimated signal component in BLACK (to
be consistent with off-diagonal covariance vectors which also should contain signal
component) and residual noise component in BLUE.
2. In the case of noise covariance matrix (MNF methods), all covariance elements – i.e.

all off-diagonal vectors should be close to zero and noise should be contained in the
main diagonal. When main diagonal of the noise covariance matrix is plotted, also
MEAN SPECTRUM is plotted in the RED. This is to confirm that spectrum counts
follow the Poisson distribution – with the variance equal to the mean. Note that with
recalibrated spectra also the first off-diagonal will contain some amount of the noise
which in turn will be missing in the main diagonal.
Example: Main diagonal display for NASVD method. Plot shows that noise variance
(blue line) was well adjusted (equal across all channels).
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Example: Main diagonal display for MNF method - noise covariance matrix. Plot shows
almost perfect match of the noise variance at the main diagonal with the average
spectrum.

Select the SmthSpectra radio button to compute and display smoothed spectra, composed
from PCA eigenvectors. This spectrum restoration functionality works in very similar
way as the LSQ fitting, except PCA eigenvectors are used instead of model responses to
restore the spectrum. While browsing through spectra, smooth spectrum is computed and
displayed over the input spectrum. Input spectrum can be stacked for better assessment
of the spectrum restoration process. By setting the Residual control it is also possible to
see residual spectrum and investigate differences between input and smoothed spectra.
The number of eigenvectors used for reconstruction is controlled by the Trim value,
which is located under the Processing section (bottom-right) of the Praga4 dialog.
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Try to change this value and observe immediate change in the restored (smoothed)
spectrum. Next to [TRIM] edit boxes are small [S] buttons which are used to launch
Eigenvector Selection Tool. Using this tool it is possible to select arbitrarily any
combination of eigenvectors for spectrum restoration process.
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Chapter 3: Processing Mode
Use [MODE] button or attached combo-box to enter into processing mode.
Praga4 can perform following processing tasks:
•

Standard window based processing

•

Least-squares (LSQ) fitting based on model detector responses

•

Principal component analysis (PCA) and spectrum restoration (smoothing)

•

Radon detection and removal

The following four steps are necessary to start any type of processing.
1. Configuration of input/output options, entering calibration constants and setting other

required processing parameters using the Options menu dialogs.
2. For LSQ fitting and PCA spectrum restoration it is recommended to test performance of

the technique in the Interactive mode with the help of visual control provided by the
spectrum browser. Note that nuclides selected for LSQ fitting are used also for
processing..
3. Use [VIEW] button or combo-box to select/configure processing tasks. Various tasks

can be performed individually or at once in the single processing session.
4. Clicking the [SEL LINE] button (bottom-right) displays the Select Lines for

Processing dialog. Note that, by default all lines are processed. Clicking the [JOB]
button starts the processing session.
Other settings and processing information
The [Show Log] button is used to display a log file for the last processing session. The
[STOP] button is used to abort the current processing session.
Before the processing starts, a window with the processing check-list is launched to assist
new users to ensure that all necessary steps were completed. Check-list can be disabled for
advanced users. Restore check-list by clicking the Run bar in the main dialog.
The Output channels are defined on the Options|Input/Output settings dialog. Output
channel names are predefined, however it is possible to modify them by attaching channel
name-prefix in order to tell apart results from different processing sessions. Praga4 can
output a lot of channels at one time, it maybe necessary for Geosoft users to grow the
database before processing.
The Spectrum stacking functionality is intended for data evaluation and testing purposes.
Make sure that the Stack value is set back to zero before processing unless you have special
reason to do otherwise (like in GROUND Survey mode, see above chapter “Airborne and
Ground Survey Modes”).
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Standard window based processing
Praga4 has standard window based processing (IAEA, 1991) implemented as a default
processing option; this means that there is no special dialog control to switch on/off this
type of processing. Standard window processing is carried out during any processing job
(which is started by pressing the [JOB] button). However, results are written into a
database only if any outputs are selected using the Options|Input/Output settings dialog.
Praga4 is a software package designed for full-spectrum rather than window based
processing. For this reason spectrum is always expected on the input of any processing
task. As a result, in the window based process, window count-rates are computed from
input spectra (and full chain of corrections is done) during every processing run. It is not
possible to compute corrected count rates, concentrations or dose rates directly from raw
window count-rates computed and output in the previous run.
T O S ET S TANDARD W INDOW P ROCESS :

On the Options menu, select Input/Output setting. The
Input/Output setting dialog is displayed. In the Window
Process Output section (centre-top) and below the From
Raw Spectra box (Raw spectrum means input spectrum
that was identified in the Define Aliases dialog as a
[DWN-SPEC] spectrum). Possible output selections
are:
Raw – output raw window count-rates in [cps].
Corrected – output count-rates corrected for
background, stripping and altitude, in [cps].
Radioelement – output corrected window count-rates
converted into concentrations in [%,ppm] or activities in
[Bq/kg]. Select required units in the Select type of Radio
Element evaluation section. Note that TC is converted to
the dose rate.
Dose – output absorbed dose rates in air
Exposure – output exposure rates
Raw, Corrected and Radioelement options always output values of 4 standard windows total count (TC), potassium (K), uranium (U) and thorium (Th). Use Units control section
(top-left) to change units of Dose and Exposure rates. Note that, Dose and Exposure rates
are evaluated using K, U and Th concentrations - in contrast with Radioelement dose rate
which is estimated from the corrected TC window using its sensitivity value.
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In the Input section (top-left) check that the Detector Volume Down is correct. Standard
airborne 2-pack system with 8 downward-looking detectors is assumed to have volume of
32 liters. Click the [OK] button to close the dialog.
On the Options menu, select ROI definitions. The ROI definitions dialog will be displayed.
Enter the calibration constants. In the case that calibration constants were entered already
during the project setup, just check that all values are correct. Calibration constants
entered in this dialog should be equivalent to standard 32 liter detector system (see the
paragraph above).
Standard window based processing with PCA smoothed spectra
Standard window process can also be applied on NASVD or MNF smoothed spectra. This
will happen when either of the two Smooth controls in the Processing section on the main
dialog (bottom-right) is set to ON – subject that eigenvectors were already computed in the
same or previous processing session. Spectra are restored from eigenvectors - the number
of eigenvectors is set by the Trim value - and standard window process is applied.
To output window based results using NASVD or MNF smoothed spectra follow the steps
above, except in the Output settings dialog use From NASVD/MNF Smoothed Spectra
controls instead of From Raw Spectra controls.
Definition of output channels
Dialog control

Type of output

Units

GDB channel names

Raw - TC
Raw - K
Raw - U
Raw - TH
Corr. - TC
Corr. - K
Corr. - U
Corr. - Th
Radioel. – TC(dose)
Radioel. – K
Radioel. – U
Radioel. – Th
Dose
Exposure
INPUT spectra
NASVD Sm.spectra
MNF Sm.spectra

Raw total count
Raw potassium
Raw uranium
Raw thorium
Corrected total count
Corrected potassium
Corrected uranium
Corrected uranium
TC converted to dose rate
K concentration or activity
U concentration or activity
Th concentration or activity
Absorbed dose rate in air *
Exposure rate *
Input spectrum
NASVD sm. spectrum
MNF sm. spectrum

cps
cps
cps
cps
cps
cps
cps
cps
nGy/h **
%, Bq/kg
ppm, Bq/kg
ppm, Bq/kg
nGy/h, pGy/s
µR/h, pA/Kg
cps
cps
cps

TCrawW
KrawW
UrawW
THrawW
TCcorW
KcorW
UcorW
THcorW
TCdoseW
KconW,
KactW
UconW,
UactW
THconW, THactW
DOSEW
EXPW
RAWspec
SVDspec
MNFspec

NASVD output names - same as above except the last letter is ‘N’ instead of ‘W’ (KrawN
etc.).
MNF output names - same as above except the last letter is ‘M’ instead of ‘W’ (KrawM etc.).
* computed using K, U and Th concentrations, no man-made radiation is taken into account.
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** units depend on the calibration constant defined in the ROI definitions dialog.

Least-squares spectrum fitting process
Introduction
Least-squares (LSQ) spectrum fitting technique is the special feature of the Praga4
software which was designed primarily for the processing of man-made (non-natural)
radiation data. It uses weighted least-squares fitting algorithm to find contributions of
individual radionuclides into input spectra. Implemented technique uses model detector
responses derived by the Monte Carlo photon transport simulation code.
Model responses were specially adjusted for the contribution of the scattered radiation and
for the peak resolution to fit characteristics of the real spectrometer system. Using new set
of detector responses, Praga4 is now able to process spectrum information from 0.2 to 3.0
MeV. Up to 12 nuclides at once can be fitted to deliver results in activity/concentration and
exposure/dose rates.
Current version comes with two sets of model responses for airborne detectors.
GRS10.RSP should be used with new Pico Envirotec Inc. (PEI) spectrometers; GR820.RSP
is intended for Exploranium GR-820 users. Model responses were adjusted for average
parameters (photopeak resolution, amount of Compton scattering) of above mentioned
spectrometers, in order to meet parameters of the specific spectrometer system, model
detector responses need to be built on demand.
Note that in GROUND Survey mode, different sets of model responses are used.
LSQ fitting technique requires full-spectrum background removal. In Praga4, modeled
aircraft and cosmic background components can be individually adjusted by the user with
the control of experimental calibration constants. To configure background removal for
LSQ process select the Options|Background model menu item (see details in the paragraph
Background removal below). Any radon removal method (full-spectrum or window based)
selected using the Options|Radon removal options dialog can be applied to the fitting
process.
Praga4 can apply fitting process on raw input spectra or on PCA (NASVD/MNF) restored
spectra computed in the previous processing session. The use of PCA restored spectra is
strongly recommended for environmental projects involving man-made radiation – to
significantly reduce statistical noise in the low-energy spectrum region saturated by
scattered radiation.
Expected benefits
The LSQ fitting process makes attempt to distribute the Entire radiation contained within
the spectrum (subject of masking) among selected radionuclides. In comparison with the
window based method (natural radioactivity, raw spectra) there will be good improvement
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in the signal to noise for uranium and also for low-activities of thorium. To see the
difference, low masking limit should be set around 500 keV to include major low-energy
photopeaks of uranium and thorium series. There is essentially no difference in results for
potassium. If the low masking limit is set just below potassium peak or the ROI mask is
used, both methods produce equivalent results. With the masking which includes also lowenergy photopeaks of uranium and thorium results should be comparable with the window
process applied on spectra after PCA restoration (smoothing).
Major benefit of LSQ fitting method is in environmental applications involving monitoring
of man-made radioactivity. Praga4 can discriminate up to 9 man-made nuclides (plus K,
U, Th) at once, delivering results in activity or exposure/dose rates. To reduce the amount
of the statistical noise at low energies (where the most of man-made nuclide photopeaks are
found), PCA spectrum restoration process is recommended prior fitting process is applied.
Model arrangements and limitations
The original calculation of detector responses with the use of the Monte-Carlo photon
transport simulation code (Cechak et al., 1994) was based on the model where the real
environment was approximated by a half-space filled by soil with the mean density and
composition and by a half-space of (standard composition) air. The depth radionuclide
distribution in the surface soil layer was set as homogenous for K, U and Th, exponential
for 137Cs and as 1 cm thick layer for all other radionuclides (except for gases). U and Th
disintegration series were expected to be in radioactive equilibrium.
Praga4 uses calculated deposition spectra which are adjusted for the amount of (Compton)
scattering and converted into detector responses by a convolution with the peak resolution
function of the real spectrometer system.
For natural radionuclides, final model detector responses are normalized in such a way
that count rates over their respective (IAEA) standard windows are equal to one. Window
based sensitivity calibration constants are applied to fitting process output to obtain results
in activity or concentration. In essence, same sensitivity correction is applied as for
standard window process to obtain reliable results based on the well established calibration
procedures.
For man-made radionuclides, on the other hand, final model responses are calculated per
1Bq/m2, therefore the fitting process provides immediately results in activity per area.
Subject to proper setup of the fitting process (see, Chapter 2: Interactive Mode page 16), it
is possible to unfold input spectra into contributions of individual natural and man-made
radionuclides even in circumstances of multiple radionuclides making complicated
overlaps within the single spectrum. However, take results in absolute values with an
extreme caution, in the most circumstances the real nuclide distribution will be different
from the distribution expected by model setup. Actual sources can be smaller than
footprint of the detector; real depth distribution can be different as well. It is strongly
recommended to perform ground survey to back-calibrate airborne data to get reliable
results in physical units for man-made radionuclides. To allow for corrections, results of
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the fitting process can be multiplied by coefficients located in the Multiply Nuclide Results
section (centre-right) of the Input/Output settings dialog.
Calculated contributions of airborne gases will always be only relative, as there is no idea
about actual detector – source geometry.
Spectrum fitting process gives reliable results under following conditions
•

Model responses must match spectra of the real detector system sufficiently well,
otherwise offsets or "leaking" can occur (for instance 609 keV uranium peak can
contribute to 137Cs anomaly etc.).

•

All nuclides which are present in the surveyed area must be selected for the fitting
process. If they are not, radiation of the missing nuclide is contributed to other nuclides,
use peak identification and NASVD/MNF functionality to identify peaks/nuclides (see
above in the Interactive mode).

•

Background has to be well defined in the full-spectrum range, usually full high-altitude
stack is required to properly define aircraft background, special care must be taken in
the case of polluted aircrafts and helicopters using defrosting devices.

Masking
By masking, number of spectrum channels used in the fitting process will be limited to a
subset defined by the LSQ MASK. Masking of the fitting process can be important;
channel subset defined by a mask should include main photopeaks of all nuclides selected
for fitting. Praga4 offers two modes of masking (i) range of channels defined by low and
high limit and (ii) set of spectrum regions (windows) around each nuclide’s main
photopeak (ROI mask). Users must be very careful with setting low-energy mask limits too
low unless there is good reason for it (photopeak of interest). The very low energy end of
the spectrum is saturated with a high amount of scattered radiation which contributes a lot
of noise. There is also possibility that amount of scattered radiation contained in input
spectra is different than expected by a model (various environmental reasons, different
depth nuclide distribution than expected etc.). It is a good idea to investigate (averaged)
residual spectrum to check how low in energy it is possible to go (read above in Chapter 2:
Interactive mode - Least-squares spectrum fitting process page 16).
Use the Correct LE functionality to adjust very low-energy end of model responses
(scattered radiation build-up) to better match input spectra.

Chapter 3: Processing Mode 33

Processing flow
The process applied to each individual data spectrum is as follows.
1. At first, full-spectrum aircraft cosmic and radon background is removed from the input

spectrum. In the GROUND Survey mode, only instrument background is removed.
2. In the AIRBORNE Survey mode, STP altitude is calculated (if not directly input from

the database).
3. Then, all nuclide detector responses selected for fitting are taken out of library of model

detector responses and interpolated for current STP altitude.
4. Responses are fitted into input spectrum using least-squares technique, weighted by a

variance of the signal across the spectrum. Only channels which are selected by LSQ
MASK are involved in the LSQ process. Praga4 package is able to process up to 12
nuclides at once.
5. Results are output into database.
6. Stripping and altitude corrections known from the standard window processing are not

part of LSQ fitting process as effects of scattering and attenuation are included in the
model design.
Outputs
All outputs are by default in activity – mass activity for natural nuclides and activity by
area for man-made nuclides. Radiation of all nuclides – natural and man-made - involved
in the fitting process is used to estimate exposure rate or absorbed dose rate in air 1 m
above the ground.
For natural radionuclides following applies:
1. Output is always controlled by same experimental sensitivity numbers as for standard

window-based processing.
2. Activity can also be converted into concentration.
3. For easier comparison with results of standard window processing, fitting results can

also be output as ‘equivalent’ window count rates in [cps].
Fitted spectrum composed out of model detector responses can be also output.
LSQ fitting technique requires following steps:
1. In the AIRBORNE Survey mode, set detector volume. On the Options menu select,

Input/Output settings and enter your Detector Volume. All results in absolute physical
units are influenced by this important parameter. 8-down-crystal / 2-pack system is
regarded as 32 litre detector volume.
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2. Select (and adjust) output channels. By default, activities of all nuclides involved in the

fitting process will be output – there is no special control to force the output, however if
necessary, results can be modified using output adjustment coefficients located in the
Multiply Nuclide Results section (centre-right) of the Input/Output settings dialog. In the
section Fitting Process Output (top-right) select all additional outputs.
3. Check validity of all input channels. Follow steps described in Chapter 1: Working

with Praga4 Radiometrics: Input/Output Settings and other important information
(page 11) and Check validity of all input channels (page 11).
4. Enter or check calibration constants. On the Options menu select, ROI Definitions and

the ROI Definitions dialog will be displayed. Check the aircraft background and
sensitivity values for natural nuclides. Fitting process uses window based aircraft
background values to model full-spectrum aircraft background. It also uses sensitivity
values for processing activity/concentration of natural nuclides. In AIRBORNE mode
Calibration values should always be entered as for 32 litre system.
5. Complete or check channel-to-energy calibration. On the Options menu select,

Spectrum adjustments to find the proper energy calibration for your input spectra (see
details Chapter 1: Working with Praga4 Radiometrics, page 7). It is essential to use
fitting with properly energy calibrated spectra, especially for processing man-made
radionuclides. After energy calibration is done and tested, decide if you want to stretch
model responses to fit input spectra - set Stretch to RESP, or if it is better to stretch
spectra to match model responses - set Stretch to SPEC.
6. Optionally adjust low-energy end of model responses. In order to process nuclides with

peaks at extremely low energies, it might be necessary to shape very low-energy end of
model responses according to input spectra. Low energy adjustment is setup during
energy calibration and can be enabled by selecting the Correct LE control on the main
Praga4 dialog. With good quality spectra it is then possible to go with masking as low
as 200 keV which is a good achievement for airborne radiometric processing based on
NaI(Tl) detectors. Use (averaged) residual spectrum to check how this functionality
works before the processing is started.
7. Configure full-spectrum background removal. On the Options menu select, Background

model and the Full Spectrum Background Parameters dialog is displayed. Adjust your
parameters used for full-spectrum background modeling (read details in the following
section, Background removal, page 34).
8. Select radionuclides and define mask for fitting process. Use the controls on the top-

right side of the main Praga4 dialog to select radionuclides and set the LSQ MASK (see
details in Masking section, page 30).
9. Test performance of the fitting process in the interactive mode. (For more information,

see Chapter 2: Interactive Mode - Least-squares spectrum fitting process page 16.)
10. -Start processing. In the Processing section (bottom-right) of the main Praga4 dialog,

select LSQ and click the [JOB] button. Check processing report (click the [LOG]
button) after the process is finished. Check data that were written into database.
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LSQ fitting process applied on spectra restored using PCA approach
The amount of the statistical noise in gamma-ray spectra can be significantly decreased by
a spectrum restoration process with the use of PCA. Noise reduction has special
importance in the processing of man-made radiation data. Almost all of the man-made
radionuclides have their photopeaks in the low-energy region of gamma-ray spectrum
which unfortunately contains high amount of scattered radiation.
To use spectra restored by PCA (NASVD or MNF) process follow the steps below.
1. Perform NASVD (or MNF) analysis and smoothing process (see details below in the

section Principal component analysis (PCA) and spectrum restoration). On the Options
menu select, Input/Output setting and the Input/Output settings dialog is displayed.
Switch on NASVD (or MNF) Smoothed spectra control to force spectrum output.
2. On the File menu select, Change Alias. The Define Aliases dialog is displayed. Select

the smoothed spectrum as your primary DOWN-SPEC spectrum.
3. Browse through the spectra in the Interactive mode and check that you see smoothed

spectra as your primary input, as expected.
4. Perform LSQ fitting process as usual.

Definition of output channels
Dialog control

Type of output

Units

GDB chn.names

K-40 *
U-238 *
TH-232 *
Cs-137 *
Co-60 *
Cs-134 *
Ru-103 *
Mo-99 *
I-131 *
Ar-40 *
Kr-88 *
K, U, Th
equivalent ”window”
counts in [cps] **
Dose **
Exposure **
LSQ fit spectra **

K-40 activity (or concentration)
U-238 activity (or conc.)
Th-232 activity (or conc.)
Cs-137 activity
Co-60 activity
Cs-134 activity
Ru-103 activity
Mo-99 activity
I-131 activity
Ar-40 activity
Kr-88 activity
K equivalent window count rate
U equivalent window count rate
Th equiv. window count rate
Absorbed dose rate in air
Exposure rate
LSQ fitted spectrum

Bq/kg (%)
Bq/kg (ppm)
Bq/kg (ppm)
Bq/m2
Bq/m2
Bq/m2
Bq/m2
Bq/m2
Bq/m2
relative
relative
cps
cps
cps
nGy/h, pGy/s
µR/h, pA/Kg
cps

K40actF
U238actF
TH232actF
CS137actF
CO60actF
CS134actF
RU103actF
MO99actF
I131actF
AR41actF
KR88actF
K40corF
U238corF
TH232corF
DOSEF
EXPF
LSQspec

* Controls located in the main Praga4 dialog, normally used to select radionuclides for
the fitting process, calculated contributions of all selected nuclides are written to a
database, there is no special dialog control to force the output.
** Controls located in the Input/Output settings dialog.
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Background removal
LSQ fitting process requires full-spectrum background definition and removal. On the
Options menu select, Background model and the Full Spectrum Background Parameters
dialog is displayed. This dialog is used to define individual background components.

Praga4 uses a special formula which approximates the shape of the cosmic background
component equivalent to 1 cps in the "cosmic channel". It is possible to individually adjust
the "continuum" part (blue line), the 511 keV peak-amplitude (red line) or Compton scatter
contribution to 511 peak (black line).
Full-spectrum aircraft background is based on K, U and Th model responses calculated for
the very close source. Responses are normalized in such a way that count rate over the
standard window is equal to one. Experimental calibration constants for aircraft
background (as defined in the ROI Definitions dialog) are used to compute final aircraft
background spectrum.

Chapter 3: Processing Mode 37

Low energy part of the model aircraft background can be adjusted using AddCompton and
ComptonAutoAdjust functions to achieve the same background value over standard TC
window as is estimated by calibration.
After adjusting the background components, click the [Recompute] button and check
window background values calculated from the model against experimental background
values – comparisons are shown at the bottom of the dialog.
Instead of modeling, total cosmic and aircraft component can be imported from the external
white-space delimited ASCII file. Columns must be in the following order: channel
number, cosmic background, aircraft background. Number of channels must be same as
for input spectra.
In the GROUND Survey mode, there is no modeling of the background component. Only
option here is to import full-spectrum background from the external white-space delimited
ASCII file. Columns must be in the following order: channel number, instrument
background. Note that in this case, the “instrument” background should include also
(static) cosmic background component which is assumed to be constant over the survey
area. Alternative way of the background import is to load (background) spectra prepared by
Praga’s “Average” function and saved into the project using “Save” function, such a file
has extension *.SPC.
Removal of the full-spectrum background for the LSQ fitting process can be disabled by
checking the Disable A/C Background control. This setting effects background removal in
both, Interactive and Processing modes.
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Principal Component Analysis (PCA) and spectrum
restoration
Introduction
In spectrum analysis, PCA methods are used to extract non-correlated spectrum signatures
- eigenvectors from the data in the presence of the noise. In gamma-ray spectrometry,
eigenvectors are actually various combinations of detector responses to radionuclides
present in the surveyed area. Responses are combined in eigenvectors according to relative
abundance of individual radionuclides in the area. Positive feature of gamma-ray
spectrometry is that (for given spectrometer installation) the detector response of the
specific radionuclide remains very much the same across the whole surveyed area. On the
other hand, detector response does change because of gamma-ray attenuation, where
variations in air layer thickness and soil/vegetation moisture are major contributors. The
good news is that within the range of common survey altitudes 50 – 120 m AGL, there is a
need for only two eigenvectors per radionuclide to be able to restore detector responses at
any altitude level (applies for NASVD below).
Using principal component method, the whole dataset (or its selected part) is converted
into single N x N covariance matrix (or data and noise covariance matrices for MNF),
where N is the number of spectrum channels. Covariance matrix is transformed into set of
N eigenvectors which can be seen as non-correlated spectrum signatures which describe
whole dataset. The quality of transformation in terms of separation of spectrum signatures
from the noise depends on statistical properties of the dataset, namely on the quantity of
input spectra and their noise content. The higher noise is present for specific spectrum
component, the more spectra is needed for transformation to separate signal from the noise.
Eigenvectors are not identical to detector responses of individual radionuclides, they are
rather their combinations. Eigenvectors can have both positive and negative values. Mean
spectrum is removed from input spectra before covariance/variance is calculated, so in
radiometrics, covariance is calculated around the mean not around the zero. Note that with
the average spectrum also (stable) part of the background is removed.
NASVD and MNF
Standard Principal Component transformation transforms dataset into set of eigenvalues
and eigenvectors which are ordered by their TOTAL (signal+noise) variance. NASVD
(Hovgaard, Grasty, 1997) and MNF (Green et al., 1988) are methods which apply PCA
approach to gamma-ray spectrometry data. The condition for PCA to work is the equal
noise variance across the whole spectrum. NASVD and MNF methods use different
approach to meet this condition.
NASVD expects radiometric data in any channel (detector stationary) to be Poisson
distributed with the variance equal to the mean value of the count rate in this channel.
Mean spectrum can be seen as an estimation for the variance of the statistical noise across
the whole spectrum. Therefore in NASVD, input spectra are normalized by a sq. root of the
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mean spectrum (and also by spectrum total count) before usual principal component
technique is applied. As a result, noise variance is equal (to one) across the whole spectrum
and computed eigenvectors are sorted by decreasing signal variance.
MNF does not make any a-priori expectations about the noise, but calculates noise directly
from the data using "shift-difference" method (difference between two consecutive
spectra). Apart from the covariance matrix of the signal+noise, also covariance matrix of
the estimated noise is calculated. MNF in NAPCA implementation (Lee et al., 1990)
performs 2 principal component transformations one after another. Final eigenvectors are
sorted according to its noise fraction rather than signal variance. MNF approach can be
meaningful if the NASVD method does not produce satisfactory results. In comparison
with NASVD, MNF method needs extra time to compute noise statistics and requires good
statistics (higher amount of spectra) to deliver reliable eigenvectors. MNF sometimes tends
to produce more signal contained eigenvectors than NASVD.
In the recent Praga4 version, MNF transformation is formulated to be as fast and effective
as NASVD method. There is a choice of 4 different methods for MNF transformation.
a) Standard – this is the MNF implementation as suggested by Green et al. (1988). This
option uses shift-difference method for the estimation of the noise covariance. Shiftdifference method was designed to suppress effects of the change in the signal component
in adjacent spectra.
b) NAPCA – (Noise Adjusted Principal Component Method). This option follows the
method described by Lee (1990). NAPCA is computed as two successive PC
transformations, at first the noise covariance matrix is diagonalised and used to normalize
signal+noise covariance matrix, the second PC transformation of the adjusted signal+noise
covariance matrix produces final eigenvectors. The NAPCA as implemented in Praga4 uses
shift-difference method to compute noise covariance matrix (same as with Standard
method). Note that Standard and NAPCA methods are mathematically equivalent. They
use different algorithms but they produce practically identical results
c) LSD – Least Squares Decorrelation method introduced by Carey and Craig (2004) is
special technique to derive noise covariance matrix directly using the data (signal+noise)
covariance without need for accumulating special noise statistics using spatially adjacent
spectra. In Praga4 implementation, LSD derived noise covariance matrix is input into
NAPCA method to produce final eigenvectors and eigenvalues.
d) sMNF – Simplified MNF is special feature of the Praga4 software. This method is
based on similar ideas as NASVD method recognizing following facts:
•

In radiometric data, noise is generally uncorrelated between channels so the statistical
noise concentrates itself in the main diagonal of the noise covariance matrix while all
off-diagonal elements approach to zero with increasing number of spectra added to the
statistics accumulation process. Noise covariance matrix IS ALREADY DIAGONAL in other words, the usual first step in the MNF techniques (i.e. diagonalisation of the
noise covariance matrix) is in fact obsolete.
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•

Using spectra from properly functioning spectrometer it can be seen that whatever is
the signal distribution because of the spatial distribution of the ground radioactive
sources, the noise distribution follows Poisson law – the noise variance (which is found
in the main diagonal of the noise covariance matrix) is equal to the average spectrum.
This is why the noise adjustment works for NASVD method.

sMNF simplifies MNF process by estimating noise covariance matrix as a (synthetic)
matrix with average spectrum at main diagonal and zeros elsewhere. The first PC
transformation is skipped as the matrix is diagonal and the whole process includes only
normalization and transformation of the signal+noise covariance matrix. This method is yet
unpublished so please use it with care.
Tip: Use functionality for display of column and diagonal vectors of covariance matrices
to prove/disprove above statements.
PCA used for quality control and data analysis
NASVD/MNF spectrum analysis is sensitive to any technical problems which may have its
effect in the data. Especially in the case of poorly stabilized spectrometer with peaks
fluctuating around their correct positions, PCA transformation will produce whole series of
eigenvectors which would reveal peak movement. In this sense NASVD/MNF analysis is
excellent tool for quality control.
Also, if the large dataset would contain only several but strong spectrum responses of
unexpected (man-made) radionuclides, their photopeaks will sure be included in
eigenvectors. It is quicker to search through N eigenvectors than investigate thousands of
spectra.
The steps to perform Principal Component Analysis
1. Set Praga’s mode to PROCESSING and set the View Mode to NASVD/MNF.
2. Adjust NASVD/MNF Subset – range of channels used to produce final eigenvectors.

The selection of the lower limit depends on the aim of your application. Be aware that
going too low means taking more noise fraction into the procedure because of the great
amount of scattered radiation. It is absolutely essential to define subset within the range
of valid spectrum channels otherwise the program can have unpredictable behaviour.
Note that the same subset is used for both NASVD and MNF methods.
3. In the group of controls switch on NASVD/MNF-Get Statistics control(s).
4. Click the [SEL LINE] button (bottom-right) to display the Select Lines for Processing

dialog. Select the lines which will be included in the PCA process.
5. Click the [JOB] button to start processing.
6. Set Praga’s mode to INTERACTIVE (read above) and use its full functionality to

assess results of the PCA process.

Chapter 3: Processing Mode 41

As a result of NASVD or MNF analysis, transformation, eigenvector and eigenvalue
matrices are written into files located within your Praga4 project directory, so the next
time the project is open, result of the last NASVD/MNF process can be displayed and
analyzed – and used for spectrum restoration process.
Principal component methods for spectrum restoration (smoothing)
Subject to good statistics in the dataset (good signal variation and sufficient amount of
data), PCA will separate responses of all radiometric sources from the noise and store them
into limited number of NASVD/MNF eigenvectors. These eigenvectors can be ‘fitted’
back to input spectra by similar way as it is done by LSQ fitting technique with the use of
model detector responses. In contrast with the LSQ fitting technique, NASVD/MNF
eigenvectors are not directly identical to responses of individual radionuclides, rather they
are their combinations.
For the spectrum restoration process, the idea is to use only those eigenvectors which
contain signal - signatures of the detector response. All eigenvectors are fitted back to the
input spectrum and their contributions to the spectrum are calculated. Then new spectrum
is composed using subset of significant eigenvectors multiplied by their relative
contributions. The number of eigenvectors in the subset is defined by the user.
It is important to realize that no matter how fine (and smooth) eigenvectors derived by
PCA process are, the high amount of the statistical noise contained in the typical 1-second
input spectrum is the cause of (unavoidable) error in the restoration process. In other
words, having absolutely smooth spectrum in the output of the PCA restoration process
does not mean that this spectrum is perfectly correct in terms of individual radionuclide
contributions.
Number of eigenvectors to use for spectrum restoration
In order to decide how many significant eigenvectors to retain for spectrum restoration
process, plots of eigenvectors and eigenvalues should be investigated. Eigenvectors which
show any presence of true radiometric signal with substantial variance should be included
in the process. Unfortunately, this approach would not always work. If there is not enough
statistics in the dataset to separate response of certain (low-radiation) radionuclide from the
noise, its weak signatures will be regarded as a noise and distributed randomly among
many (noisy) eigenvectors. Assessing the sharpness of the final image (after complete
processing and gridding) while using different number of eigenvectors is not the way either
as the sharpness always increases with the decrease of the number of eigenvectors retained
for restoration. The practical way to avoid this situation is to feed as many of spectra as
possible into PCA (transformation stage) – to produce good quality eigenvectors.
Alternatively, gridding of residual spectra (spectra restored from eigenvectors assumed to
be noise) might be the way to ensure that there is no signal lost. Note that, Praga4 includes
an Eigenvector Selection Tool to select any combination of eigenvectors for restoration
process.
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For NASVD and good quality data (without problems with spectrometer stabilizing), the
golden rule will be to use 1 + 2*N eigenvectors, where N is the number of radionuclides
including radon and man-made radionuclides. Usually, the first eigenvector is the average
spectrum, and then follows N eigenvectors for mixtures of responses at main altitude, then
N eigenvectors which account for response variations due to altitude changes. To be on the
safe side in the geological environment including radon gas, we should retain a minimum
of 9 eigenvectors or 11 if the 137Cs fall-out is present. In the condition of poor statistics –
having low amount of data in small projects, low radiation with a high fraction of the noise,
low signal variance etc., it is wise to use more eigenvectors to prevent signal loss.
For MNF it is usually necessary to include more eigenvectors than suggested above for
NASVD.
The steps to perform spectrum restoration
1. After NASVD or MNF analysis/transformation stage was completed as described

above and eigenvectors were processed and inspected to be correct, switch again to
PROCESSING mode and set the View Mode to NASVD/MNF. Set Smoothing control
on. Enter the required number of eigenvectors to be retained into the Trim edit box.
Note that, both processes – transformation and spectrum restoration (smoothing) can
also be done within the single processing session. In such a case just switch either
NASVD (or MNF)-Get Statistics and Smoothing controls to on, and enter the number
of required eigenvectors.
2. To perform standard window processing using smoothed spectra and output results

follow all instructions given above in the section, Standard window based processing
used with spectra smoothed by PCA process (page 27).
3. Using the Menu|Options|Processing settings dialog, select processing options for

NASVD or MNF methods, the same dialog can be accessed also trough Options button..
This dialog also provides Eigenvector Selection Tool which is equivalent to the
Selection Tool which is accessible from the Main dialog (using S buttons).
4. To select the required window based outputs, on the Options menu, select Input/Output

settings. The Input/Output settings dialog is displayed. Optionally, use controls in the
Output Spectra section to output NASVD/MNF smoothed spectra and array of
eigenvector amplitudes into database.
5. To select a subset of flight lines for processing, click the [SEL LINE] button. The

Select Lines for Processing dialog is displayed. Use this dialog to select lines for
processing.
6. In the main Praga4 dialog in the Processing section, click the [Job] button. Check

processing report (click [LOG] button) after processing is finished. Check data written
into database.
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The use of spectrum restoration for LSQ fitting and radon detection
The LSQ fitting process is designed to make use of low-energy photopeaks – especially if
man-made radionuclides are of interest. The use of PCA restoration process improves
performance of the method delivering significant noise reduction in the low-energy
spectrum region where photopeaks are obscured by a build-up of scattered radiation. Same
applies for radon detection techniques which also make use of low-energy 214Bi or 214Pb
photopeaks.
This approach requires PCA restored (smoothed) spectra to be defined as a primary input
spectra for LSQ fitting and radon removal:
• Perform NASVD (or MNF) restoration process with the spectrum output as
described above
• On the File menu, select Change Alias and then select the smoothed spectrum as
your primary [DOWN-SPEC] spectrum
• browse through spectra in the Interactive mode to ensure that PCA smoothed spectra
are used as a primary input spectra, as expected
• perform LSQ fitting or radon detection process as usual
It has to be noted, however, that spectral-ratio method of radon removal comes with an
option to use NASVD restored spectra even if they are not defined as a primary input
spectra. In that case NASVD eigenvectors have to be already computed and present in the
project structure before radon removal detection run.
Support for recalibrated spectra
Spectra which were recalibrated in such a way that original channel count rates were
interpolated have property of non-zero correlation (covariance) of the noise component
between adjacent channels. This is seen in the data (signal+noise) and noise covariance
matrix – the majority of the statistical noise accumulates in the main diagonal, however
part of the statistical noise accumulates also in the first off-diagonal vector. Without
interpolation, statistical noise accumulates only in the main diagonal. This is not a problem
for MNF methods which estimate noise from the data, in NASVD; interpolation changes
the usual shape of higher-order (noise bearing) eigenvectors which look to be smoother.
As the higher-order eigenvectors are excluded from the inverse transform, it is unlikely that
spectrum restoration will be affected by the spectrum recalibration process. However to
make eigenvectors consistent with non-calibrated spectra, Praga4 includes ARS option
(covariance matrix Adjustment for Recalibrated Spectra) which adjusts data covariance
matrix in such way that the effect of the channel interpolation (noise correlation between
adjacent channels) is removed. Resulting eigenevectors look like eigenvectors of spectra
where channel count rates were not interpolated. ARS adjustment is required also for
sMNF method applied to recalibrated spectra as it uses synthetic noise covariance matrix
based on expected Poisson distribution.
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Radon detection and removal
Introduction
Radon removal is one of the most difficult and challenging tasks to be done during
processing airborne gamma-ray spectrometry data. The contribution from airborne radon
gas at the usual survey altitude can be often several times that emanating from uranium
ground sources. If left uncorrected, the radon background component can corrupt the
whole chain of radiometric processing and preclude the production of seamless uranium
and ternary data images.
The spectral ratio method suggested by Minty (1992, 1998), based on the 609 keV and
1765 keV photopeaks of 214Bi has been to date the most accepted technique for radon
removal. However, it has an inherent difficulty when processing data with a high 137Cs
contribution such as is widespread in the Northern Hemisphere. Also, this method suffers
from the inability to resolve in a satisfactory way the photopeak overlap of the 208Tl at 511
keV and the 583 keV with the 214Bi 609 keV photopeak, in cases where there is strong
thorium radiation.
The solution to this problem is the use of 214Pb photopeak (in the uranium disintegration
series) instead of the 214Bi 609 keV photopeak. This concept has been known for many
years; however it has not been introduced into regular data processing practice. The main
obstacle in the implementation of this concept has been the fact that 214Pb photopeaks are
found in the low energy part of the spectrum where there is a high degree of noise caused
by the build up of scattered radiation. However, advances in modern instrumentation and
in multichannel processing techniques (PCA methods) allow the utilisation of 214Pb
photopeaks for radon removal in daily practice. Especially data from new generation of
PEI spectrometers with improved spectrum linearity and high resolution (512 channels for
each crystal in the sensor array) are very well suited for spectral-ratio method using 214Pb
photopeaks.
Implemented radon detection methods
Though the theory behind radon removal methods seems to be clear, practical
implementation comes with many challenges and pitfalls. Some method or approach might
work well with particular dataset (or spectrometer) while another dataset might require
different approach to bring better results. All methods have some stronger and weaker
sides and no one seems to be “general-purpose” method for all spectrometers and all types
of datasets. To solve radon problems under various conditions, Praga4 offers whole range
of radon detection methods:
•

Full-spectrum method

•

Spectral-ratio using 214Bi 609 keV photopeak

•

Spectral-ratio using 214Pb 352 keV photopeak
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•

Spectral-ratio with combination of

•

Upward looking detector method

214

Bi and 214Pb methods

Spectral ratio methods have an option to use stripping correction or Compton removal to
evaluate count rate of standard K, U, Th windows.
Processing flow
Radon removal process has two stages which can be run at once or separately:
1. Analysis – with the use of any method listed above, radon contribution to the

individual spectra is estimated and resulting radon anomaly along the flight line is
output to the database. This processing cycle usually requires spectra which are stacked
to reduce statistical noise – to allow for Compton removal used by spectral ratio
methods. Full spectrum and upward looking detector methods might be run without
stacking. Radon Analysis applied on NASVD/MNF spectra may also use lower rate of
spectrum stacking.
2. Removal – this stage is applied as an integral part of actual processing using standard

window or LSQ fitting methods. At the beginning, radon anomaly for the current flight
line is loaded from the database into memory. Radon anomaly is smoothed along the
flight line by a linear filter, interpolated or approximated by a polynomial. Optional
translation using scale and offset factors can be also applied. During processing, radon
is removed as a part of background correction. Stacking set in the main dialog will be
effective in the radon removal stage.
Spectrum stacking which is applied during the radon analysis stage is independent on
the stacking controlled by Stack value in the main Praga4 dialog – the later is used for
spectrum browser functions in the Interactive mode and for final processing.
All radon detection/removal options including spectrum stacking (analysis stage) are set
using the Radon Removal Options dialog accessed through the Options|Radon settings
menu (see below in Configure radon detection and removal).
The steps to perform radon removal process
1. Turn Praga into PROCESSING mode and set View mode to RADON.
2. Decide on method for radon detection and configure radon removal (see section

below, Configure radon detection and removal).
3. Analysis stage – radon detection can be run alone in order to allow for assessment of

radon anomaly before actual removal. In this case, on the main Praga4 dialog switch
the Analyse control (bottom-right) to On, optionally select flight lines to process and
start processing by clicking the [JOB] button as usual. As a result of this process, radon
anomaly will be input into database. In the database (*.GDB) the output will always be
a channel named as “pgRDN”, without possibility to modify it using output name prefix.
If necessary, this radon channel can be further processed outside Praga4 using Oasis
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montaj tools, before removal is applied. If any other tasks are selected for processing
during this (radon Analyse) session, they will be normally completed, radon anomaly
will be output, and however, radon removal will not be applied to output uranium data.
4. Assess outcome – radon analysis stage using plot of line averages. Click the [Radon]

bar to display the Data Plot dialog, investigate radon anomaly with U, K, Th and other
data.
5. Removal stage – requires radon anomaly already present in the database (for GDB

database always “pgRDN” channel). Switch the Remove control to On and process all
(standard window, LSQ fitting) tasks as usual. Output uranium and total count channels
will have radon background removed.
6. To perform both Analysis and Removal in the same session, just switch both

Analysis and Remove controls to On, and then select and configure required processing
tasks, select flight lines and click the [JOB] button.
Configure radon detection and removal
The Radon Removal Options dialog, accessed from the Options|Radon settings menu,
enables you to configure the radon detection and removal process. The upper section of the
dialog is used for setting Analysis (detection) stage of the process which calculates and
outputs radon anomaly. Options will be discussed in paragraphs below.
The bottom section of the Radon Removal Options dialog is used for the radon Removal
stage - to filter and adjust radon anomaly before it is removed as part of the background
during radiometric processing. Set the order of the polynomial for approximation of radon
anomaly or the length of linear smoothing filter. Linear or spline interpolation is applied in
data intervals given by the value of the Spectrum Stack.
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The TC/U window count ratio for Radon spectrum (bottom-right) is used to correct total
count window using radon anomaly computed for uranium window. It is also used for the
Upward Looking Detector method.
Use Scale and Offset controls to adjust final radon anomaly by scale and offset factors if
necessary.
Note that, Spectrum stack, Scale and Offset controls are identical to Stack, Sc and Off
processing controls in the main Praga4 dialog (View mode RADON), and it does not
matter which ones are used.
Radon removal and PCA spectrum restoration process
Full spectrum and spectral ratio radon removal methods will gain great benefit from the use
of PCA spectrum restoration process. Especially the spectral ratio method based on 214Pb
352 keV photopeak requires noise reduction provided by NASVD or MNF methods to
deliver satisfactory results. Run Analysis stage (or alternatively the whole processing) with
NASVD/MNF smoothed spectra selected as your primary input spectra. For details, look
above in section Principal component analysis and spectrum restoration - The use of
spectrum restoration for LSQ fitting and radon detection (page 41).
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Full spectrum method
Full spectrum radon removal technique uses spectrum fitting approach to find contribution
of the whole radon response into input spectrum. The figure below presents the difference
between radon spectrum and uranium spectrum at altitude 60 m AGL. Both spectra were
normalized over the standard uranium window.

During Analysis stage of radon processing, usual LSQ fitting technique is applied,
differential component as shown above is computed for the current altitude and included in
the fitting process as additional model response. Contribution of the differential
component found by fitting procedure is directly proportional to the amount of the radon in
the spectrum.
In the current Praga4 version the radon spectrum is approximated by a model response for
the very close uranium source. Use Scale and Offset (or Sc and Off) controls to adjust
computed radon anomaly, should there be disagreement between model and real data.
Note that full spectrum radon detection technique can be applied in conjunction with LSQ
technique or even with the standard window processing within the single processing
session. During the Analysis stage spectrum fitting is internally applied and radon
anomaly is computed and output to database, in the Removal stage radon anomaly is
loaded back, radon background is removed and LSQ fitting or standard window process is
applied on raw or PCA smoothed spectra.
Spectral ratio method - Introduction
The spectrum observed in an aircraft is comprised of both primary and scattered radiation the relative contribution of which changes with the distance from the source. In
discriminating the effect of the atmospheric radon (around the aircraft) from the
contribution of ground based sources, we are assisted by its presentation as typical of a
close radioactive source; that is, the lower energy portion of its spectrum is not attenuated,
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as it would be had it traveled through a large air column. The figure below shows the
increase in the attenuation of uranium photopeaks with the increasing altitude (increasing
thickness of the air layer between the detector and ground sources). Spectrum ratio method
is based on the fact that lower energy photopeaks are more attenuated by interactions with
the matter that higher energy ones.

Spectral ratio method – Compton continuum removal
In the observed spectrum, the primary radiation is presented by distinct photopeaks.
However the observed spectrum also contains both primary and scattered radiation
contributions to the Compton continuum. By Compton continuum we mean smooth
distribution of energy deposited in a gamma detector caused by the partial absorption of
energy from the Compton scattering process.
In order to investigate the rate of attenuation of the low energy uranium photopeaks part of
radiation produced by Compton scattering has to be removed. Therefore, Compton
continuum removal is an important part of the spectral ratio method. See the example of
the Compton continuum removal process below.
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Compton continuum removal requires high degree of noise reduction to be applied to
individual spectra, especially for the isolation of low energy photopeaks at 352 or 609 keV.
Spectra have to be sufficiently stacked; PCA spectrum restoration process is highly
recommended.
The mask for Compton continuum removal which is used during radon detection stage is
independent from the Compton removal mask used by a browser in the main Praga4
dialog. Radon Compton removal mask is internally set to 310 – 2800 keV. The low-limit is
set just at the beginning of the 352 keV 214Pb photopeak. In the case that 352 keV radon
detection method is used, channel-to-energy calibration must be done perfectly, so that
error at the low energy end of the input spectrum will be within one channel. It is
important to check the energy calibration using the following procedure:
1. In the browser, set stacking to a high value (>50), use PCA smoothed spectra for the

best results.
2. Set Stretch control to RESP and select R/Compton.
3. Set the low COMPT/REM Subset limit below 250 keV. Then [Go] through the spectra

until two 214Pb at 295 and 352 keV are clearly seen.

4. Place the cursor to the channel which is closest to the 310 keV. Check that the cursor

is located exactly between two 214Pb peaks. Cursor must not reach into area of 352 keV
peak.
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Spectral ratio method – treatment of high energy photopeaks
Praga4 comes with two options on how to evaluate standard window count rates around
main (high energy) photopeaks of K, U and Th - following concepts proposed in two
papers by Minty (1992, 1998). The Spec Ratio Type section (top-right) of the Radon
Removal Options dialog (Options|Radon settings menu) is used to switch between those
two options.
1. The Compton/Rem option uses count rate computed above Compton continuum for all

spectrum windows, as shown in the figure above. The advantage of this approach is low
sensitivity to the quality of the aircraft/cosmic background removal. On the other hand,
the evaluation of the count rate in the standard uranium window above the Compton
continuum is easily obscured by interference of thorium photopeaks (around 1.6 MeV)
in conditions of high thorium and low uranium levels; as a result uranium count rates
tend to be significantly underestimated.
2. The Stripping option uses standard stripping approach to compute count rates in

standard K, U and Th windows, while the low-energy uranium window is processed
using the same Compton removal technique as for the first option. This approach does
not suffer from problems described above; however, it is quite sensitive to the quality of
the background removal applied to the standard uranium window. Error in the
estimation of calibration constants – especially for cosmic background – might cause
significant offsets in the computed radon anomaly.
Spectral ratio method – formula
Formula used to compute radon count rate in the low energy uranium window is as follows,
LR = ( LOB - C2UOB – C3ThOB ) / ( 1 – C2/ C1) ,

(1)
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Radon count rate in the standard uranium window (radon background) is computed as:
UR = QR * ( LOB - C2UOB – C3ThOB ) / (C1 – C2 ) ,

(2)

where:
L is count rate above Compton continuum for windows around peaks at 352 or 609 keV
U and Th are uranium and thorium window count rates above Compton continuum (Option
1) or standard window count rates after stripping correction (Option 2),
LOB, UOB and ThOB are window count rates calculated from the observed spectrum after
aircraft/cosmic background removal,
C1 is L/U ratio for radon spectrum,
C2 is L/U ratio for uranium spectrum,
C3 is Th into L stripping value (Th strip).
QR is ratio of uranium window count rates: (standard window)/(above Compton c.)
for radon spectrum,
QR = 1 for the option 2 which uses stripping correction for high energy windows
Spectral ratio method – discussion of C1 and C2 ratios
The success of spectral ratio depends strongly on correct definition of C1 and C2 ratios.
The theory suggest experimental test such as over-water and test range flights to derive
those precious coefficients. While it is not too difficult to find value of the C1 ratio,
estimation of the C2 and its altitude dependence is real challenge. With reasonable sized
datasets, data dependent techniques can be used as an alternative to experimental tests.
In practice, data processor faces many obstacles in the way to apply spectral ratio method
correctly. Spectral ratio method is extremely sensitive, subtle changes of C1 and C2 values
have great impact on the processed radon anomaly. The degree and the method of noise
reduction applied to the input spectrum influences strongly Compton removal process and
subsequently evaluation of window count rates. Noise which is not removed well enough
from the spectrum prior to Compton removal will give rise to the positive offset of the
computed radon anomaly. In other words, the style of processing might have significant
influence on final results.
The parameter C2/C1 as seen in the formula (1) describes sensitivity of the method to tell
apart radon response from the uranium response at given altitude. The figure below
illustrates the altitude dependency of this parameter for both low energy uranium windows
(352 keV and 609 keV). The curve for the window around the 352 keV photopeak shows
much better discrimination thanks to higher attenuation at lower energy. However, it is
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necessary to consider higher amount of the noise in this spectrum region so the suitable
noise reduction approach (such as NASVD spectrum smoothing) is required for the radon
detection method using 214Pb photopeak.

Spectral ratio method – adjusting C1 and C2 ratios
In the Radon settings dialog which is used to configure radon removal, C1, C2 and C3 values
as defined in formulas (1) and (2) are referred as C1, C2 and Th_strip. Spectral ratio
method as implemented in Praga4 expects the C2 and C3 values to be a function of altitude
while C1 value to be altitude invariant. The values of C1, C2 and Th_strip and their altitude
dependency are predefined with the help of modeling. Use scaling factors C1_scale,
C2_scale and Th_scale to modify them.
To assist with C1, C2 adjustments, after radon Analysis stage, Praga4 outputs the
project_name.RDN file into the project directory. This file contains flight line averages of
radon related data such as estimated Rn, U, K, Th levels, differences U-Rn and more. Data
can be displayed using the Data Plot window, which is displayed by clicking the Radon
bar in the main Praga4 dialog. The *.RDN file from the last radon Analyse run (related to
the radon anomaly present in the database) will be displayed.
The effect C1, C2 and Th_strip value adjustments on computed radon levels is as follows.
1. Radon profile of flight line averages (as presented by Data Plot window) :

• The change of the C2 gives rise to the offset of the radon profile. C2 increase creates
negative offset, decrease creates positive offset.
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• The change of the C1 modifies amplitude of the radon profile. C1 increase scales
profile down, decrease scales radon profile up.
2. Radon profile – along flight line

• Incorrect value of the C2 causes radon profile to be correlated with the final uranium
profile, the lower C2 values bring about higher radon levels, positively correlated
with the uranium profile and vice versa.
Spectral ratio method – the use of the 214Pb photopeak
Note that option, which is based on the 352 keV peak of 214Pb, has zero influence from
cesium and thorium sources. This is great advantage over the traditionally used method
using 609 keV 214Bi photopeak where the wrong setting of the C3 value (Th_strip) will give
rise to significant offsets in the computed radon anomaly.
Due to high noise content in the window around the 352 keV photopeak, spectrum
restoration using NASVD or MNF methods is strongly recommended. Using this
approach, low degree of stacking or even no stacking at all is necessary during the Analyse
stage of the processing.
There are two options how to use NASVD spectra with spectral ratio method.
1. Run Analysis stage with NASVD/MNF smoothed spectra selected as your primary

input spectra. For details, look above in section Principal component analysis and
spectrum restoration - The use of spectrum restoration for LSQ fitting and radon
detection (page 41).
2. Select Use NASVD spectra option in the radon options dialog. In this case, normal raw

spectra are in the input as usual, however, they are replaced (on-fly) for NASVD
restored spectra for the purpose of radon detection process. NASVD eigenvectors must
be computed and present in the project structure before radon detection is performed.
NASVD analysis (Get Statistics) cannot be performed in the same run as radon
detection.
With high resolution data, the Peak 352 keV option is recommended as the first choice of
radon detection method.
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Upward looking detector – standard method
Standard method of radon removal based on upward-looking detector is implemented,
following IAEA standard (IAEA, 1991). It is highly recommended to be familiar in detail
with this method prior its use. Implementation of this method uses 6 parameters:
Ground radiation parameters - expressing net contribution of ground radiation into upward
Uranium window:
U_UP/U_DOWN(A1) and U_UP/TH_DOWN(A2) ,
related by formula : ug = A1 * Ug + A2 * THg , where
ug is upward uranium window count-rate, Ug is downward uranium window count-rate,
THg is downward thorium window count-rate
Radon radiation parameters - expressing net contribution of radon radiation
U_UP/U_DOWN(Au) – relation of upward/downward window count-rates for uranium
window based on formula:
ur = Au * Ur + Bu, where
ur is upward uranium window count-rate, Ur is downward uranium window count-rate, Bu
is offset value
TH_DOWN/U_DOWN(At)
relation of thorium and uranium downward window count-rates based on formula:
THr = At * Ur + Bt, where
THr is downward thorium window count-rate, Ur is downward uranium window countrate, Bt is offset value
Background/offset parameters
Parameters Bu and Bt (defined above) should correct for possible imperfections in
definition of ur and THr data, which essentially means imperfection in the background
removal for those windows.
IMPORTANT: Because Praga currently does not store background values for upward
spectrum window, Bu must in any case include background value for upward uranium
window (plus possible offsets, if any). Upward uranium background must be exact value
for given detector volume (not recalculated for 32L detector).
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Upward looking detector – TC method
Upward looking detectors were used for radon detection for many years. The main problem
with this method was high amount of the noise associated with the count rates in the upper
detector uranium window. Praga4 brings the solution with the use of the full total count
instead of the noisy uranium window. In the current version, the TC method is still in the
development stage (beta version). Please take results with extreme caution.
TC method has just three adjustment parameters:
UP/DOWN - ground radiation – the scaling parameter related to the proportion of ground
radiation collected in the downward and upward-looking detectors.
UP/DOWN - radon - the scaling parameter related to the proportion of radiation which
enters downward and upward-looking detectors from all directions.
TC/U window count ratio for Radon spectrum – ratio of standard TC and uranium
window count rates computed for radon spectrum.
To see and investigate properties of upward detector spectra instead of downward spectra
in the Interactive mode – open the Input/Output settings dialog go to the Input section and
select the Show Upward control.

Synthetic data
Least-squares fitting process using model detector responses includes option for creating
dataset equivalent to the project dataset where input spectra will be replaced by fitted
model spectra. Statistical nature of radioactive process is simulated by the use of dedicated
random noise generator with the Poisson distribution. Synthetic data might be useful for
analysis and testing of various processing techniques (such as Principal Component
methods etc.). The advantage of Praga’s implementation is that model responses are
perfectly smooth without any residual noise so the derived counts follow Poisson
distribution exactly.
Steps to output synthetic dataset
Setup LSQ fitting process:
•

On the Options menu, select Input/Output settings. The Input/Output settings dialog si
displayed. On this dialog go to the group [OUPUT SPECTRA] and select [LSQ
spectra] together with [Add noise]

•

Then, select other necessary data streams from [AUX DATA] section

•

Go back to Main dialog and change Praga Mode to PROCESSING, set View to
STD/FITTING and make sure that you have selected [LSQ Fit] control.
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•

Select lines to process using the [SEL LINE] button, and start process by pressing the
[JOB] button.

Note:

In current Praga4 version, synthetic data output option is an extension to the LSQ
fitting process. As the input spectra for the fitting process are in general A/C
background corrected, synthetic data (= fitted model spectra with added noise) will
be also A/C background free.
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